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Chapter 1. Getting Started                                                                 

“Hey, Logy, whatcha doing?”

“What’s it look like I’m doing.  I’m 
cleaning the windows so we can get 
started on our new adventure.”

“Can’t you leave the housekeeping until 
later.  We’ve got Logo work to do!”

“Well, that’s why I have to get the 
windows ready.  This time we’re going 
to use Microsoft Windows to discover 
lots of things we can do with Logo!

“You know, Ernestine even brought along her whole 
family…that’s more than 1,000 turtles for you to play with.  

“And you can now play music through your new sound 
card.  You can even use Logo to make up your own 
Windows programs.   

“Just wait until you see the trouble you can get into!”

“Yeah, yeah, yeah” Morf said, bounding around very 
excited.  “What do we have to do?  When can we get started.  
I’ve got lots of ideas I want to try out!”
________________________________________________

Installing 
MSW Logo

OK, OK!  Let's get started!
Since you were given MSW Logo with this book, the 

first thing you need to do is install MSW Logo on your 
computer…that is, after you make a backup of the diskette.
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To install MSW Logo and the sample procedures for 
Windows 3.1:

1. Make sure you are at the MS-DOS prompt, not in 
Windows.  Put the MSW Logo diskette in drive A and 
type a:install.  (a:inst95 for Windows 95.)

2.  Then follow the instructions on the screen…the rest is 
automatic.

3.  Remember...after MSW Logo is installed, you should 
exit Windows right away to install the procedures from 
this book and LOGO32.EXE, if you are using WIN32.  
The last step is to erase the temporary directory and 
files that were created for the installation.  This is done 
automatically.

4.  Be sure to read the README file that is copied to your 
MSW Logo directory.  It tells you about the procedures 
included with the book.  Just type README.

________________________________________________

Looking at 
Logo

When you install MSW Logo, Windows puts it in its 
own program group or folder.  Open the program group 
or folder and there’s Logo in its own little window.  

Double-click on the Logo icon in that little window to 
open MSW Logo.
________________________________________________
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Parts of the 
Screen

There's Ernestine sitting at right in the middle of her 
playground.  Ernestine looks like a pointed arrow but she's 
really a turtle who does just about anything you ask her to 
do.  If she doesn’t understand, she’ll tell you.

Now let’s take a look at the rest of the MSW Logo 
screen.

It’s like many Windows screens.  The Title Bar is at 
the top.  This tells you what window you’re looking at.  

The Menu Bar is right below the Title Bar.  It holds 
the names of menus we’ll describe a bit later.

Title Bar
Menu Bar

Turtle’s Playground

Turtle

Commander
Input Box
Command Box
Command Buttons

 Window



Getting Started

10                                                                                                           

Down below the playground is the 
Commander.  This where the action is.
  
The big space in the Commander 
window is the Command Box.  This box 
keeps a list of what’s going on.  If 
something goes wrong, you’ll see a 
message here. 

Below the Command window is the 
Input Box.  This is where you type your 
commands.

Over on the right side, there’s a bunch 
of buttons that can make things a little 
easier. 

The Commander window is a separate window from the 
MSW Logo window.  That means you can move it 
around, make it smaller or larger, or you can change it 
into a little icon.  We work with this window a lot.  So if 
you want to practice a bit, go ahead.

1. Click in the Title Bar where you see the word, 
Commander.  

The title bar of the Commander window changes 
color.

2.  Press and hold the left mouse key down.  Then drag the 
Commander window around the screen.

The Commander window moves as you move the 
mouse.

3.  Move the Commander window back where it is 
supposed to be and release the mouse button.

________________________________________________
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MSW Logo 
Menus

There are five menus in the Menu Bar. You know what 
a Menu is, don’t you?  You click on the word and up pops 
a list of choices.

File:  This gives you a list of things you can do with your 
procedures; things like Load them into your workspace, 
Save them, Save them using another name, Edit them, 
and Erase them.
Bitmap:  Bitmap is a technical term for picture.  This 
menu includes commands for working with pictures that 
you design.
Set:  You can change the type of letters and numbers that 
Logo uses by setting the “font” in this menu.  You can 
also set colors.
Zoom:  You can Zoom in on your pictures to make them 
bigger.  Or you can Zoom out to make them smaller.
________________________________________________

Where to Go 
For Help

If you have questions about how to do something in 
MSW Logo,  you can click on Help.  The Help Menu pops 
up and gives you some choices. 
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The Help Menu gives you some choices:
Index:  Click on Index to see a list of the chapters in the 
MSW Logo On-line Help.
MCI:  This is for Multimedia programmers, something 
we won’t be covering in this book.
Using Help:  This is a neat section.  It will help you if you 
need help using Help.  

Does that make sense?
Tutorial:  That didn’t make it in this version.  This book 
will have to do.  You’ll find the tutorial on CompuServe 
and on the MSW Logo home page on the Internet.
http://www.ultranet.com/~mills
Demo:  Select Demo to see a neat demonstration of some 
of the things that MSW Logo can do.
Examples:  Examples are just that, examples of MSW 
Logo procedures.  Study these procedures after you finish 
this book to discover lots of other things you can do with 
MSW Logo.
Release Notes:  This tells you all about the things that 
MSW Logo has to offer.  It’s the same as the 
MSWLOGO.TXT file in your MSW Logo directory.  
About Logo:  This tells you who developed MSW Logo.  
It also provides e-mail addresses where you can contact 
the developers.
________________________________________________
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Commander 
Buttons

Morf loves buttons and things.  So here’s a list of the 
Commander buttons.  We’ll talk more about them later as 
we go along.
Halt:   This stops all the Logo action right away.  It does 
the same thing that the HALT command does.

Trace:  This turns the Trace command on.  Click on it to 
turn the Untrace command on.

Pause:   Logo stops the action temporarily and waits for 
the Continue command.

Status:  The Status button brings up a Status window 
that tells you what’s going on.

Yield:  This tells Logo not to allow other programs to run 
while Logo is running.

Reset:  This button is like the Clearscreen command.  It 
resets or clears the screen.

Execute:  This is like pressing the Enter key.  It tells the 
turtle to execute your procedure.

________________________________________________
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Meet the Turtle
Time to get down to business!

Look down in the Input Box.  If you don’t see a blinking 
line over on the left side, click in the Input Box.  That 
blinking line is “the cursor.”  It moves every time you type 
something in a window, dialog, or text box. 

But you probably knew that already.  So, let's get on 
with the fun!

Ernestine carries a pen that she uses to create all sorts 
of colorful drawings.
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But remember, you are the one who has to tell here 
exactly what to do.  
________________________________________________

Turtle Directions
She can go…

FORWARD

BACK

LEFT
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RIGHT

When you tell the turtle to move, you have to tell her 
how many turtle steps to take.  Go ahead.  Try it.  

1. Type FORWARD.  

2.  Press the SPACE bar.  

3.  Then type a pretty big number... like 200 or something 
like that.  

4.  For the turtle to hear you, you have to press ENTER.

 

If you accidentally hit the wrong key and end up with 
something like FORWRD 200, the turtle tells you…

I don’t know how to FORWRD.

She’s nice about it.  So just type the command again, 
but without any more accidents.

To turn the turtle, tell her to turn RIGHT or LEFT.  
Again, just as you have to tell her how many steps to take 
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to move forward or back, you have to tell her how many 
turtle turns to make. 

RIGHT ______  

Go ahead!  Type in a number…not an itty-bitty 
number…make it a pretty big one.

What happened?  The turtle turned to look in another 
direction, right?

OK, now turn her back to the direction she was 
heading before.  

Type LEFT ______ and use the same number of turtle 
turns that you used before.  Remember to press Enter.

Now the turtle is looking up toward the top of the 
screen again.   How many turns does the turtle have to make 
to look at the side of the screen (or page)?

What do you think?  Why not write down your 
answers?

__________ was too __________ (too big or too little?)

__________ was too __________ 

__________ was too __________ 

__________ was too __________ 

The Answer is __________!
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This is the cool part of Logo.  You get to discover all 
sorts of new things all by yourself.  You found that the turtle 
had to turn 90 turtle turns to look at the side of the screen.

Now, turn the turtle back to the top of the screen.  What 
do you have to type to do that?

If you said LEFT 90, give yourself a double-dip ice 
cream cone!

Now…what do you have to do to get the turtle to face 
the bottom of the screen?

Well, you could tell the turtle to face the side twice, 
right?

RIGHT 90 RIGHT 90

That should work, shouldn’t it?

What would happen if you add the 90 and 90 together?

Did you get 180?  Morf did.  Why not give that a try?

RIGHT 180
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That did it!  There’s the turtle facing in the opposite 
direction.  

So…when you tell the turtle to go FORWARD or 
BACK, the turtle moves forward or back the number of 
turtle steps you tell her to go.  When you tell the turtle 
RIGHT or LEFT, she turns in that direction the number 
of turtle turns you tell her to turn, but she doesn’t move.

Get the idea?  Try a few moves on your own.

FORWARD 100 RIGHT 90

FORWARD 100  RIGHT _____

BACK _____   RIGHT _____

BACK _____   LEFT _____

LEFT _____ FORWARD _____

That’s it.  Now just mess up the screen real good with 
turtle tracks.  As you type in numbers watch what the turtle 
does.  Pretty soon, you’ll be able to tell the turtle just where 
you want her to go.  

Now have some fun practicing.
________________________________________________

Cleaning Up 
After Yourself

By now the screen is either a work of art or a big mess.  
So you’d better clean it off.  To clear the screen, type…

CLEARSCREEN

You can also set the RESET button.  That’s one of the 
Command buttons down in the Commander.



Getting Started

20                                                                                                           

Everything on the screen is erased and the turtle 
goes home.

To clear the screen but leave the turtle in the same 
place, type CLEAN.  

Yep, that’s the turtle’s home, right there in the middle 
of the Window. 

OK, so maybe Home doesn’t look exactly like the 
picture.  But you get the idea.

When you tell the turtle to go HOME, she goes back 
to the middle of the screen and faces the top of the screen.  

Remember this, you’ll use the HOME command a lot.
____________________________________________________________________
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Rabbit Trail 1. Turtle Games Off the Computer 

Have you ever played SIMON SEZ or MOTHER, 
MAY I?  Why not try these games using Logo commands 
instead of the regular things you do?  Logo commands add 
some new fun to the old game.

Simon sez FORWARD 5
Simon sez RIGHT 90
FORWARD 5

For another change, let's take a turtle walk that's a lot 
like these games.  This one is fun to play with your class in 
school or with your family or friends at home.

One player is the turtle and one is the computer 
operator.  The idea is to tell the turtle how to walk through 
a big letter or shape.  The others in the room have to guess 
what the turtle is drawing.  

The turtle starts in the middle of the room.  The 
operator then tells the turtle how to move.  The commands 
listed below will give you an idea.  

FORWARD 10     turtle steps.  
Make them little steps if you are in a small space.

RIGHT 150      turtle turns.  
Remember how you turned right before?  You tried 
RIGHT 90 to turn to the side.  Then you tried RIGHT 
180 and you turned around to face the opposite direction.  
150 is closer to 180 than it is to 90.  So you can make a 
good guess about how far to turn.  It will do just fine.

FORWARD 11     turtle steps

LEFT 150       turtle turns.   
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You don’t have to be reminded you about this one, do 
you?  I bet you know which direction you should be 
heading.

FORWARD 10     turtle steps

Now type these steps on the computer.  Of course, you 
don't need to type the “turtle steps” or “turtle turns.”  

What letter does this shape look like?  How would you 
make this shape bigger on the screen?  

If you make the turtle move five times as many turtle 
steps forward, do you have to make the turtle turn five 
times as many turns?  
________________________________________________

SPECIAL NOTE:  The words you 
type...FORWARD, RIGHT, BACK, and 
LEFT...are Logo “primitives.”  
Primitives are the action words that are 
the basic building blocks of Logo 
procedures.  They're the things MSW 
Logo can do.  As you will see later, 
primitives are procedures the turtle 
follows to make things happen.

________________________________________________

Let’s experiment.  (Morf loves experimenting.)
Type this…

FORWARD 10 * 5
RIGHT 150
FORWARD 11 * 5
LEFT 150
FORWARD 10 * 5
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(The * sign tells the turtle to multiply 10 times 5 and 
move that many turtle steps.  You’ll learn more about 
Logo arithmetic later on.  If you want to take a peek now, 
that’s OK.)

What happened?  

The shape got bigger.  But it still looks like the letter 
N doesn't it.   So I guess that means that turtle steps and 
turtle turns really are different!

Changing the number of turtle steps changes the size 
of the shape.   But it's still the same shape.  Changing the 
number of turns changes the shape itself. 

 
Go ahead...change the number of turtle turns.  Change 

150 to 120.  What happens when you change it to 180?  Why 
not try 310?  As you play around with numbers, you'll begin 
to see how you can make the turtle do just what you want 
it to do.  

Now...think about this.  What would happen if you 
changed the * 5 to a * 8?  No…don’t do it on the computer.  
Draw the change you think this might make.  Then see if 
you were right.

Don't worry about what you're drawing or what the 
turtle's trail looks like.  This is the time to explore...to 
discover what the turtle can do with the four commands… 
FORWARD, BACK, RIGHT, LEFT.

Go on...give it a try!
________________________________________________
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Learning Turtle Shorthand
Now that you know what these commands are and 

what they will do, let's make things easy.  You can type 
these commands in shorthand like this.

FD        is the same as      FORWARD

BK        is the same as      BACK

RT        is the same as      RIGHT

LT        is the same as      LEFT

CS        is the same as      CLEARSCREEN

Get the idea?  

Good...then let's try a few.  Here's a list of commands.  
Some are already done for you.  Why don't you fill in the 
blanks.  Then type your own commands on the computer. 

FD 100 RT 120 FD 60 BK 30

LT ____  FD ____  RT ____  BK ____
________________________________________________

The Turtle’s 
Pen

So far we've been talking about the turtle drawing all  
the time.  Ernestine always has her pen down to draw on 
the screen.

But what if you want to move the turtle without 
drawing?  What do you do then?

You guessed it...you tell the turtle to pick up the pen.
Try it.
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PENUP  or PU
FD 100  RT 90

To tell the turtle to start drawing, tell her to put the 
pen down.

PENDOWN or PD
FD 50

Awfully simple?  Or simply awful?
Don’t think you’re going to get off this easy!  There’s 

more to it than that.

In MSW Logo, the turtle can do three things with the 
pen when it is down: PAINT, ERASE, and REVERSE.

PENPAINT  
The turtle draws lines.

PENERASE  
The turtle erases its steps.

PENUP or PU              PENDOWN or PD
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PENREVERSE  
This command turns 
the turtle into a little 
“troublemaker.”  If 
there’s a line in the 
turtle’s path, it is 
erased.  If there is no 
line, the turtle draws 
one.

Let’s put these commands to work.
________________________________________________

Erasing Did you ever type something you didn't mean to type?  

Well, all you have to do to change it is to back up and 
type over the things you want to change.  You can use the 
Backspace key to back up…that’s the one with the arrow 
pointing to the left.  That erases what you’ve type one letter 
at a time.  Then type what you want to change again.

Or you can use the DELete key.  That one erases what 
you typed as you move backwards.  Go ahead, give it a try. 
You’ll see the difference.

The other way to erase is to drag the mouse over the 
text you want to change.  Drag means to put the cursor in 
front of the section you want to change.  Press and hold the 
left mouse button.  Then drag the cursor…move the 
mouse… over the words to be changed and release the left 
mouse key.

The marked section reverses color.  

To change what you’ve marked, just start typing.  The 
marked section disappears.
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OK...you know you can erase things that you type.  But 
what about things you draw?  Think about this.  

You have just finished a great drawing when you see 
a line that's too long.  You don't want to start all over again.  
All you want to do is erase that one line.

Let's try it.  Draw this shape.

FD 50

RT 120

FD 50

RT 120

FD 60

Rather than erase the entire drawing because the last 
line is too long, just change what the pen is doing.  Since 
you want to erase that last line, you just move the turtle 
back over it. 

 Type this…
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PENERASE or PE
BACK  or BK 60

What happened?  Just as important, what do you do 
now?

If you said to tell the turtle to paint again, 
CONGRATULATIONS!  Give yourself a huge Gold 
Star…and throw in a double-dip ice cream cone too!

To start drawing again, tell the turtle to PENPAINT.

OK, now type…FD 50

Now what do you see?   Looks better, doesn't it.  

Try this... Now try this...

FD 50 RT 90

RT 45 FD 75

FD 75 LT 90

PE FD 100
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BK 75  PD

LT 90 BK 50

______  ______   

Sometimes it’s fun to just play around on the screen to 
see what you can do.  Other times it is fun to plan a drawing 
on paper first, and then put it on the screen.

Why not give that a try?
____________________________________________________________________

Rabbit Trail 2. Making a Pencil Turtle

Here's an idea to help you make a turtle drawing on 
paper.  Let's make a turtle for your pencil.  Use one like 
that is shown below or make your own turtle.

To make your own…

Using your pencil, 
make a drawing of an 
egg on a piece of 
heavy paper or 
cardboard.  
If you're at home, 
maybe you could ask 
your Mom or your 
Dad for help tracing 
a real egg.  
But be careful, you 
don't want egg all 
over your drawing.

Hold the egg carefully and then trace around the egg 
to draw an oval shape.  This looks like a turtle shell, doesn't 
it.



Getting Started

30                                                                                                           

Now put a small circle in the middle of your turtle shell 
about the size of your pencil.  At the top of the shell, draw 
the turtle's head.  Then draw the turtle's right legs.  Then 
draw the turtle's left legs.   Now you're ready to cut out 
your turtle.

Carefully cut out your turtle.  Then slide the turtle up 
near the top of your pencil so you can hold it underneath 
the turtle.  If it seems to slide around too much, use a piece 
of cellophane tape to hold it in place.

 There’s a whole bunch of turtles on the next page if 
you want to give some to your friends.  Just make a copy 
of the page or just cut them out.

Ready to go?  Make sure the turtle is looking at the top 
of the paper.  Then give the pencil turtle a command like...

FD 50

When you want the pencil turtle to turn, turn your 
pencil so the turtle is facing where you want to draw your 
next line.

RT 90

FD 50

LT 90

FD 50

Get the idea!
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When you want to plan a drawing on paper, your 
Pencil Turtle can help you think about the moves the turtle 
will have to make on the screen.  

To help you even more, while you’re making a drawing 
on paper, make a list of the commands you give your pencil.  
Then you can type them on the computer.
____________________________________________________________________

Let’s Review You know how to tell the turtle to go FORWARD, 
BACK, LEFT, and RIGHT.  You can tell to turtle to draw 
with the PENUP or the PENDOWN.

  
Do you remember where HOME is?

What happens when you tell the turtle 
PENREVERSE?

What about CLEARSCREEN?  CLEAN?

OK!  Time to do some more exploring!
____________________________________________________________________
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Rabbit Trail 3. Turtle Baseball
Everybody likes baseball!
Well, just about everybody.
Anyway, you’ll find that playing baseball on the 

computer can be lots of fun.
Put four small stickers on the screen.  If you don't have 

stickers, use tape.  Don't press to hard.  You want the 
stickers or tape to stick but you also want to be able to 
unstick them, too.

Can you put the turtle on First Base in no more than 
three moves?  Good, you're safe.  

Now go to Second Base in three moves or less.  Then 
go to Third.  And now go Home.

Get some friends together and see who can run the 
bases in the fewest number of moves.  To add some more 
fun to your game, move the stickers to different spots on 
the screen. 

Copy the next page onto a sheet of plastic.  Then tape 
it over the screen.  Using this picture, you don’t need the 
stickers.
____________________________________________________________________
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Logo Football If you don’t like baseball, why not try Logo Football.  
Logo and Morf live near Dallas, Texas, the home of the 
Dallas Cowboys.  So they’re real big football fans.

Here’s how to play Logo Football.

One team is the offense and one is the defense.  The 
team that is on defense must place eleven small stickers on 
the screen to stop the offense from getting a touchdown. 
They can place them anywhere on the screen.  Only there 
must be enough room between the defense stickers to allow 
the turtle to go through without touching any of the 
defensive players.

The defense can also draw their defensive players on 
a piece a clear plastic taped over the screen, using an 
erasable marker.  Use the drawing on the next page if you 
want.  When the defense becomes the offense, all you have 
to do is wipe off the plastic and redraw the defense 
wherever they want it.

 The offense has to move the turtle from their goal line 
through the defense to the goal line on the other side of the 
screen without touching a defense sticker.  The offense gets 
four downs, or four chances to make a touchdown.  If they 
don’t, they have to turn the ball over to the defense who 
then gets their chance to make a touchdown.

Logo football is a lot of fun, especially if you live in a 
big football town.

“But what about the extra point?”

“Well, why don’t you make up your own rules about 
extra points after the touchdown.”
________________________________________________
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Make Up Your 
Own 
Adventures

Now...why not make up some adventures of your own?

To give you an idea, why not draw the letters of your 
name.  Take a look.

There's all sorts of things you can dream up, I'll bet.  
Go on...see what you can do!
________________________________________________

Learning to Say Good-bye
When you want to leave Logo,

Type BYE

A message is displayed asking you if you really 
want to leave Logo.

Click on OK.
Don't forget to press ENTER after you type a 

command.  That's the only way the turtle will know what 
to do.

You can also open the File Menu and left-click on Exit 
at the bottom of the menu.  A message is displayed asking 
you if you really want to leave Logo.

Click on OK.
________________________________________________
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Writing Your Own Journal
As you explore Logo, you’re going to discover all sorts 

of things.  There are spaces in this book to write things.  
But it is also a good idea to have your own book where you 
can write down ideas and other things you want to 
remember.

That’s how Logy did it.
________________________________________________


